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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy
with your purchase of Ross Technology.
Our mission is to:
1. Provide a Superior Customer Experience
« offer the best product quality and support
2. Make Cool Practical Technology
+ develop great products that customers love

Ross has become well known for the Ross Video Code of
Ethics. It guides our interactions and empowers our employees.
| hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to
your expectations be sure to reach out to us at
solutions@rossvideo.com.

—Dao\ 2\!5

David Ross
CEO, Ross Video
dross@rossvideo.com



Ross Video Code of Ethics

Any company is the sum total of the people that make things
happen. At Ross, our employees are a special group. Our
employees truly care about doing a great job and delivering a high
quality customer experience every day. This code of ethics hangs
on the wall of all Ross Video locations to guide our behavior:

1.  We will always act in our customers’ best interest.

2. We will do our best to understand our customers’
requirements.

3.  We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology,
when something big goes wrong and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no

one to authorize the required action in times of company or
customer crisis - do what you know in your heart is right. (You
may rent helicopters if necessary.)



XPression e Quick Install Guide

¢ Ross Part Number: 3500DR-006-08
* Release Date: July 4, 2019.

Printed in Canada.

The information contained in this Guide is subject to change
without notice or obligation.

Copyright
© 7/4/19 Ross Video Limited. All rights reserved.

©2019 Ross Video Limited, Ross®, and any related marks are trademarks
or registered trademarks of Ross Video Limited. All other trademarks are
the property of their respective companies. PATENTS ISSUED and
PENDING. All rights reserved. No part of this publication may be
reproduced, stored in a retrieval system, or transmitted in any form or by
any means, mechanical, photocopying, recording or otherwise, without
the prior written permission of Ross Video. While every precaution has
been taken in the preparation of this document, Ross Video assumes no
responsibility for errors or omissions. Neither is any liability assumed for
damages resulting from the use of the information contained herein.



Patents

Patent numbers US 7,034,886; US 7,508,455; US 7,602,446; US
7,802,802 B2; US 7,834,886; US 7,914,332; US 8,307,284; US
8,407,374 B2; US 8,499,019 B2; US 8,519,949 B2; US 8,743,292
B2; GB 2,419,119 B; GB 2,447,380 B; and other patents pending.

Notice

The material in this manual is furnished for informational use
only. It is subject to change without notice and should not be
construed as commitment by Ross Video Limited. Ross Video
Limited assumes no responsibility or liability for errors or
inaccuracies that may appear in this manual.






Contents

Chapter 1: System Configuration

Minimum System Requirements 2

Chapter 2: Software Installation
Requirements 6
Pre-Configuration for Windows 10 6
Software Licensing 17
Software Installation 18
First Launch 30

Chapter 3: Your First XPression
Creating with XPression 36






System Configuration



Minimum System Requirements

XPression products are based on mainstream PC hardware using the
Windows® operating system. To ensure that XPression software will
function correctly, verify that the computer selected to run XPression
software meets the recommended minimum hardware configuration.

To verify a computer for XPression, complete the following steps:

1. Verify that the computer meets the following minimum
hardware specifications:

+ Intel® CPU i7 7800X 6 Cores 3.5GHz

+ 8 GB DDR4 RAM

+ GTX 1070 8GB 256-Bit GDDR5 GPU

+ Single Zippy® HU2-5760V power supply - 750watt

* AJA® CorVid22 2Ch SD/HD/3G IO (for Studio, Player,
BlueBox, and Prime)

* 500 MB free disk space

2. Verify that the computer meets the following software
specification:

* Microsoft® Windows® 10 Pro 64-bit Operating System
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3. Ensure that the operating system is updated with all the
necessary security patches and service packs before installing
XPression software.

A detailed hardware requirements specification sheet is available
from Ross Video.
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Requirements

A valid XPression installation password, a valid USB dongle, and an
XPression software USB are required to install XPression software
on a computer.

Before starting the installation procedure, verify that the XPression
computer meets the minimum system requirements listed in the
section “Minimum System Requirements” on page 2.

Pre-Configuration for Windows 10

Before installing the XPression software on a computer running
Windows 10, the following security settings need to be configured:

* local admin rights
» User Account Control notifications

* behavior of program elevation
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To allow local admin rights, complete the following steps:

1. Click the IEM (Start) menu and select Windows System > This
PC.

The This PC browser window opens.
2. Right-click on This PC and select Manage.

O e e °

« « 4 [E Thispe v @] [[search This pC 5]

4 Folders (7)

3D Objects Desktop

cations (2)

The Computer Management window opens.

3. Double-click Local Users and Groups.
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4. Double-click the Groups folder.

The Groups folder files are listed in the browsing pane of the
Computer Management window.

File Action View Help

e 2E a3 HE

& Computer Management (Local| Name Description Actions
~ [t system Tools 9 Access Control Assist... Members of this group can remot. lGows -
(@ Tk Scheduler &
@ Event Viewer Backup Operators  Backup Operators can override se. More Actions 4

@ Shared Folders 8 Cryptographic Operat... Members are authorized o perfor.
¢ 3 Local Users o0 Groups | 5 Dictibuted COM Users Members are lloweetfo aunch,
3 Users event LogReaders  Members ofthis group can read e

| Groups
© Pertomance B Guests Guests have the same access as m.

& Device Manager
© €3 Storsge
2 Disk Management
2, Sevices and Applications

B Hyper-V Administrators Members of this group have com
s uses Buil-in group used by Internet Inf.
B Network Configuratio... Members n this group can have s
performance Log Users  Members of this group may sche.
performance Monitor .. Members of this group can acces
Bpower Users Power Users are included for back.
8 Remote Desktop Users  Members inthis group are grante.
& Remote Management... Members of this group can acces

B Replicator Supports ilereplication in 2 dom,
8 System Managed Acc... Members of this group are mana.
Busers Users are prevented from making
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5. Double-click Administrators.

The Administration Properties window opens.

B v

Descrtion:  Adminitrators have complete and unvestited acoess
1o the computer/domain

Members:

[pmm—

6. Click Add.

The Select Users, Computers, Service Accounts, or Groups
window opens.

‘Selecthis object type

=
Enterthe object names to select (examples)
I
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7. Enter a user in the Enter the object names to select arca.
Click Check Names if necessary.
8. Click OK.

To adjust the User Account Control notification settings, complete the
following steps:

1. Click the [ (Start) menu and select Windows System >
Control Panel.

The Control Panel browser window opens.
2. From the View by list, select Small icons.

The All Control Panel Items browser window opens.
3. Click User Accounts.

The User Accounts browser window opens.
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4. Click % Change User Account Control settings.

The User Account Control Settings window opens.

Choose when to be notified about changes to your computer

ur computer.

@ Recommended ifyou use famils programs snd visit
_l- familr webstes

fox

Software Installation 11



5. Drag the notification marker to the Never Notify setting.

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful programs from making changes to your computer.
count Control setfings

Never notify me when:

6. Click OK.

To change the behavior of program elevation, complete the following steps:

1. Click the H (Start) menu and select Windows System >
Control Panel.

The Control Panel browser window opens.
2. From the View by list, select Small icons.

The All Control Panel Items browser window opens.
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Select Administrative Tools.
The Administrative Tools browser window opens.
Double-click Local Security Policy.

The Local Security Policy window opens.

File Acion View Help
> B X=dm
5 Security Settings Name Description
- Account Polcies
+ L Locsl Policies

A Account Policies Password and account lockout policies

A Local Policies. Auditing, user rights and security options polici
» (] Windows Firewall with Advanced Sec|
iy | Windows Firewall with Advanced Security  Windows Firewall with Advanced Security
I NetworkLi icon and location group policies.

, 1 ublic Key Polcies

» [] Software Restriction Policies 1 Public Key Policies

» ] Application Control Policies i L e e

. 8 1 Secuty Poltieson Loce Computd] 1 Applction Cotrol Piicies Appliction Control Plicies

- s s i ot TR S —
| Advanced Audit Policy Configuration.  Advanced Aucit Policy Configuration
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5. Double-click Local Policies.

3, Security Settings Name - Description

> @ ‘:HTUP""PD““ES A Audit Policy Audit Policy

4 [Bglil ocalBolicies| A User Rights Assignment. User Rights Assignment.
A Security Options Security Options

4 User Rights Assignment

7 Security Options.

> [ Windows Firewall with Advanced Sec)
| Network List Manager Policies

> (1 Public Key Policies

1 Software Restrction Policies

1 Application Control Policies

1P Security Policies on Local Computs

| Advanced Audit Policy Configuration
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6. Double-click Security Options.

File Action View Help

|

3

2 Securty Settings
- (i Account Policies
4 14 Local Policies
U AuditPolicy
» LA User Rights Assignment
4 Security Options
+ () Windows Firewall with Advanced Sect
1 Network List Manager Polices
1 Public Key Policies
» (] Software Restriction Policies
+ () Application Contrl Policies
+ 8 I Secury Polices on Locsl Compute
+ 1 Advanced Auit Polcy Configuration

Policy

5 Accounts: Administator account tatus
Accounts: Guest accountsatus
Accounts: Lt localaccount use of blank passwords o co
Accounts: Rename administator account
| Accounts: Rename guest account
Audit: Audit the accessof global system objects
Audit: Audit the use of Backup and Restore priviege
Audit: Force audit policy subcategory settings (Windows Vs
Audit: Shut down system immediately i unble to log ecur
DCOM: Machine AccessRestitions inSecuriy DescriptorD.
DCOM: Machine Launch Restictionsin Securiy Descrptor
Devices: Allow undock witho having to log on
I Devices: Allowed t format and ejec removable media
Devices:Prevent users from instaling printer drvers
Devices:Restrict CD-ROM access o locally logged-on user
I Devices: Rstrict floppy access tolocaly logged-on use only
I Domain controlle: Allow server opeatorstoscheduletasks
Domain controller: LDAP server signing requirements
Domain controller: Refuse machine account password chan
Dormain member:Digtally encryptorsgn secure channeld
) Domain member: Digtally encrypt secure channel data (wh.
Domain member:Digitallysign secure channel data (when

Domain member oaseword chan.

Securiy Setting B
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7. In the Policies column, double-click User Account Control:
Behavior of the elevation prompt for administrators in
Admin Approval Mode.

The User Account Control: Behavior of the elevation prompt
for administrators in Admin Approval Mode window opens.

LocalSecurty Set

) A

8. In the Local Security Setting tab, use the list to select Elevate
without prompting.

9. Click Apply.
10. Click OK.
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Software Licensing

Ross Video uses licenses to manage XPression software usage.
XPression licenses are stored on a USB dongle that accompanies the
XPression Software USB dongle.

Before installing XPression software, connect the XPression License
USB dongle to a USB port on the XPression computer. The dongle
automatically installs when connected to a USB port.

If the dongle is not connected, the following Warning opens when
attempting to install XPression software:

"j Error initializing hardware protection: No valid hardware key was found.
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Software Installation

The XPression License USB dongle must be connected to the
XPression computer before running the XPression software installer
from the XPression Software USB dongle.

To install XPression software, complete the following steps:

1. Log on to the XPression computer as a user that can install
software.

2. Shut down all Windows applications.

3. Connect the XPression License USB dongle to a USB port on
the XPression computer.

4. Insert the XPression Software USB dongle into a USB port on
the XPression computer.

5. Double-click the XPRESSION software dongle to open it from
the drive it was inserted.
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Double-click the XPression .exe file to launch the XPression
installer.

The Select Setup Language screen opens.

‘Select the language to use during the installation:
i

Select a language from the list.
Click OK.

The Setup - XPression Studio wizard opens.

Welcome to the XPression Studio
Setup Wizard

Studo version: 5.5buid: 456100

Click Next to continue, or Cancel to exit Setup.
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9. Click Next.

The License Agreement screen opens.

ROSS VIDEO LIMITED

END USER SOFTWARE LICENSE AGREEMENT

10. Read the end user license agreement.

11. Select the I accept the agreement option to continue the
installation.
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12. Click Next.

The Password screen opens.

13. In the Password box, enter the supplied Xpression installation
password.
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14. Click Next.
The User Information screen opens.
(X

15. In the User Name box, enter the name of the XPression
software user.

16. In the Organization box, enter the name of the organization
licensed to use the XPression software.
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17. Click Next.

The Select Destination Location screen opens.

‘Select Destination Location v
Vihere should XPression Studio be installed? .

Setup wilnstal XPression Studio into the folowing foder.

Atleast 225.4 M of free disk spa

18. Accept the current installation folder or click Browse to select a
custom installation folder.
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19. Click Next.

The Select Components screen opens.

Setect Components v
ichcmponents shoukbenstled? ' »

; cear
instal. Clck Next when you are ready to contie.

Full installation

2618
643M8
2318
0.5M8
0.5M8
.6M8

Current selection requires atleast 292.1 M8 of disk space.

20. Accept the default XPression installation, or define a custom
configuration. To define a custom configuration, select or clear
the check boxes to the left of the following options:

* XPression Video Coder — install the video rendering engine.

+ DataLinq Server — enable live templates to be automatically
filled out using data from external sources.

* XPression DataLinqClient Library — install the NET
assembly for controlling Datalinq through API.

* XPression Script Engine — enable VB scripts to be applied to
individual graphics.
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* XPression .NET Assembly — install the .NET assembly for
controlling XPression through API.

¢ XPression Video Codec — install the XPression video codec that
includes alpha.

21. Click Next.

The Select Start Menu Folder screen opens.

22. Accept the current Start Menu folder for the XPression shortcut,
or click Browse to select a custom Start Menu folder.

Software Installation 25



23. Click Next.

+ If installing XPression Studio, Prime, Designer, Developer, or
Player, the Select Additional Tasks screen opens.

Proceed to Step 26.

‘Select Additional Tasks v

Studo, then cick Next.

+ If installing XPression BlueBox, the Enable Auto Logon screen

Enable Auto Logon v
‘to be logged on the
et
Enable Auto Logon

26 Software Installation



24,
25.

26.

27.

Select or clear the Enable Auto Logon check box.

In the User Name box, enter the name of the XPression
software user.

In the Password box, enter the password for the XPression
software user.

Proceed to Step 27.

Select or clear the check boxes to the left of the following
options:

Create a Desktop icon — install an XPression shortcut on the
desktop.

Create a Quick Launch icon — install an XPression shortcut in
the Quick Launch toolbar.

Create a Startmenu icon — install an XPression shortcut in the
Start menu.

Create a Video Coder Desktop icon — install a Video Coder
shortcut on the desktop.

Create a DataLinq Server Desktop icon — install a Datalinq
Server shortcut on the desktop.
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28. Click Next.

The Ready to install screen opens.

Ready to Install v
Setupis now ready t begin nsaling Pression Studo on your computer .
-

CickInstal the installation, or
change any settings.

Destnatio
Copr

ton
Files (x86) WPressionsStudio

29. Click Install to begin installing XPression software.

A progress bar displays the installation status. After the installer
finishes installing the required files, the Completing the
XPression Studio Setup screen opens.

Completing the XPression Studio
Setup Wizard

setph: staling XPression Studio on your
mputer ation may be aunched by selecting the
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30. Select or clear the check boxes to the left of the following
options:

* Run XPression Studio — start XPression Studio after finishing
the software installation.

* Show Changes — show the change log after finishing the
software installation.

31. Click Finish.
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First Launch

The first time XPression is run on a computer, the First Time
XPression Setup wizard opens to guide you through configuring a
hardware render and an output.

1. On the XPression computer, use the Start menu to select All
Programs > XPression > Designer.

After XPression starts, the first screen of the First Time
XPression Setup wizard opens.

Vielcome and thank you for instaling YPression.

select the desired antr-sliasing mode you wil reaure.

ROSS
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Click Take Me to the Preferences.

The Hardware Renderer panel of the Preferences dialog box
opens to select the graphics device used by XPression to render
scenes to output framebuffers.

Use the Adapter list to select the graphics device installed in
the XPression computer.

Use the Anti-Alias list to select the Multi-sampling value used
to control the visual quality of rendered output.

The higher the multi-sampling value, the smoother the rendered
the graphic edges. The <none> option is equal to 1x multi-
sampling. For most situations, set the multi-sampling value
according to the best quality/performance ratio, usually around
8x.
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5. Click OK.

The the second screen of the First Time XPression Setup
wizard opens.

6. Click Take Me to the Hardware Setup.

The Inputs / Outputs tab of the Hardware Setup dialog box
opens to select the output framebuffer used by XPression to
output or preview scenes.
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10.

Click the Add.
The Add New FrameBuffer Board dialog box opens.

Use the Brand list to select XPression Virtual FrameBuffer.

Press F1 to open the Help file to view information about the
available framebuffers that can be configured for XPression.

Click OK.

An XPression Virtual FrameBuffer is added to the Inputs /
Outputs tab of the Hardware Setup dialog box.

In the Hardware Setup dialog box, click Close.

The Hardware Setup dialog box closes to complete the First
Time XPression Setup wizard.
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Creating with XPression

XPression consists of three integrated components, the scene editor
for template design, the sequencer for playout, and the BlueBox
engine for rendering. XPression uses virtual outputs to show an
accurate and real-time preview so that you can design, create and test
projects right at your desk. The procedures in the following sections
will guide you through the creation of a simple project.

X The procedures in this section are not applicable to the
XPression™ Player and XPression™ BlueBox products.

New Project

To create a new XPression project, complete the following steps:

1. On the XPression computer, use the Start menu to select All
Programs > XPression > Designer.

2. In XPression, use the File menu to select New.

The Confirm dialog box opens.
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3. Select one of the following options for the current project:

* Yes — save changes to the current project, then close the project.
* No — close the project without saving changes.

» Cancel — continue working on the project.

After selecting Yes or No, the New Project dialog box opens.

D DI 10501 ]

)
il
il

=

4. In the Presets panel, expand any video format node to view the
available settings presets for the selected video format.

The available settings presets are displayed for the selected
video format.
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5. Select a setting preset to define video format setting for the new
project.

The settings in the selected preset are displayed in the Settings
section.

6. Click Browse to the right of the Location box to select a folder
in which save the new project.

The Browse for Folder dialog box opens.

7. In the Folder tree view, locate and select a folder in which save
the new project.

8. Click OK.

In the New Project dialog box, the full pathname of the selected
folder is displayed in the Location box.

9. In the Name box, enter a name for the new project.

Project names may only contain letters, numbers, spaces,
hyphens, or underscores.

10. Select the Create Project Structure check box to automatically
create folders within the project folder to store project items
(audio, video, dedicated fonts, images. models, etc.).
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11. Click OK.

A new project is created and saved in the project folder. Project
file are saved with the extension .xpf.

Simple Text

To create a text object, complete the following steps:
1. In the Base Objects section of the Object Library view, click
Text.

A new text object is added to the top-left corner of the Main
Viewport.
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2. In the Object Inspector, click the Scene Fonts tab.
3. In the Fonts section, click New.

A new font is added the Stock list.
4. In the Stock list, click the new font.

In the Font Face tab, use the available settings to format the
new font.

In the Fonts section, click Apply.
Type “My First XPression”.

LN

iy First Xrression

8. In the Object Inspector, click the Transform tab.
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9. Edit the values in the Position section to move the text box to a
new location in the scene.

My First XPression

Alternatively hold down the Ctrl key, then click and drag the
text object to a new location in the scene.

10. Select File > Save.

The new text is saved with the project.
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